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Software 
Software is the name given to program(s) or application(s) that you use to benefit from your computer. 
Some types of software are: 

• Games (any kind) 
• Financial  
• Netscape or Internet Explorer 
• Internet Chat & many other Internet things 
• Word Processor (typing) 
• Birthday Card Making 
• Music & Video (So you can translate a digital file into an audible sound.) 
• Picture Viewers (So you can translate a digital file into picture.) 

 
Software can be used for many purposes. The only things limiting which software you can use are the hardware 
limitations within the computer. If you need to use software that need parts that you don’t have you can either 
improve your existing computer or consider purchasing a computer that does what you need. If the span between what 
you have and what you need is too great you may have no option but to purchase a newer and more up to date one. 
 
One common software program that you all will use is called Windows 95.  
Windows  95, 98, 2000, Me, or XP, although it is software it is not a program that you will want to try changing. This 
particular software is called an “Operating System” and without it functioning properly, you will NOT be able to use 
anything on your computer. If there is a good reason to switch to a new operating system, please allow the work to be 
done by a professional.  
 
The common meaning of “software” is something that works inside of the Windows  or DOS operating system. When 
you go to a computer store and you see the rows of boxes lining the shelves these are all what we refer to as software.  

 
Hardware 

Hardware is the name given to the pieces that are put toge ther to make a computer. 
 
Some different kinds of hardware are: 

• Monitor is similar to a TV. You look at your monitor to see what you are doing with your computer. 
• Tower is the tall box that holds many smaller hardware parts. 
• Keyboard is the part you type on. 
• Printer for printing! 

 
Inside hardware includes things like: 

• Modem 
• Sound Card 
• Hard Drive 
• Floppy Drive 



• CD Drive 
• Motherboard 
• Video Card 
• Parallel Port 
• USB Port 
• And much more! 

 
 
The hardware decides what a computer is capable of doing: 
• If the computer’s brain (the processor chip) is slow then fast programs (software) may not run on that machine. 
• If the computer’s modem (the phone dialing gizmo) is slow then any connection to the Internet will be slow. 
• If the computer’s filing cabinet (the hard drive) is too small you won’t be able to fit large programs. 
• If your monitor is small then you may not be able to see all of a document if the letter size is readable. 
 
What hardware does not decide: 
If you do math or design houses. 
The colors of your screen (desktop). 
 
 

Mouse 
The mouse is a device that is used to communicate with your computer.  
• The mouse consists of a ball to roll guiding your cursor along. The ball can be on either the top (as in a traditional 

style mouse) or the bottom of the mouse (like a trackball). 
• Some mice have two buttons while others have three. When there are two buttons one is left and one is right. Both 

buttons have special functions. The left button is the primary one for most actions. The right one will often bring 
up special menus with new options & choices. 

• On a three-button mouse the middle button can be set to several uses. A common use of the middle button is for 
the “double-click”. A “double-click” is the same as two left clicks that occur close together.  

The mouse is the main way to choose what you want or need to do with the computer. A mouse only works within the 
Windows  Operating System.  

 
Windows 

You have heard of it, now its time to learn about it! 
 
What are Windows? 
 
To begin this lesson we will give you a tour of the Windows  environment.  
To begin we will get you up and running.  
• Turn on the computer! ☺ 

• Find power button on outside of your computer’s tower; press to turn it on.  
• Wait for just a few minutes while your computer is getting ready to work for you.  
• Take a look at your screen (desktop). What do you notice right away? 

__________________________________________________________________________________ 
 
 
• We will begin by looking into the Start button. 
• The Start button is located at the left end of your _______________________. 



• The Start button is how nearly everything is begun and sometimes ended with.  
• To turn off the computer click “Start” and then choose “Shut Down”. Follow instructions on the screen. 
 
Lets start by looking at the main elements of the Start button: 
1. When you click the Start button a menu going up lists several options. Many of these choices will create 

additional menus from them.  
2. When you hold your cursor over any line on the menu you will see it change color. This 

is called highlighting. If you click your mouse it will begin the program that is listed.  
3. If the name has an arrow following it then a new menu will appear from that point.  
• ** If your cursor moves off the highlighted area you desired then a different action will 

occur than what you may have planned on.   
 
Explain options in the Start menu: 
Shut Down:  ___________________________________________________________ 
Log Off:       ___________________________________________________________ 
Run:             ___________________________________________________________ 
Help:            ___________________________________________________________ 
Find:            ___________________________________________________________ 
Settings :      ___________________________________________________________ 
Documents : ___________________________________________________________ 
Favorites:    ___________________________________________________________ 
Programs :   ___________________________________________________________ 
 
Windows are similar to individual sheets of paper that can be reshaped and resized, as you 
want to.  
 

When you want to write a letter you would see a sheet of paper representing a blank page appear. This page 
may fill your computer screen or it may be smaller. If it is smaller than full size you can maximize it by 
making it fill up your computer screen (desktop).  
          _____________ 
          |                          Maximize  Button: This makes your page _______________________. 

    | 
    |------------------- Minimize  Button: This makes your page ___________________________. 
          ___________  
          |           Restore down but not all the way down to minimize, also works to restore up but not to full 

size. 
                | 
                |-------------- Close this program. Close is the same as exit. 
 
When you minimize  a program it is still running and none of your information has been lost. The minimize 
action will change the shape of the page to a small button at the bottom of your Windows 95 screen. To see a 
program that you have minimized simply click on its corresponding button in your taskbar at the bottom of 
your screen.  
When running Windows  you can be using more than one program at a time. For example you are using the 
Internet and you are using that information to send to a friend in a written letter. To switch between programs 



you can simply minimize  one to see the other one that is beneath the first one, or you can click the taskbar button for 
the program you want to see.  
               ____________________________________Taskbar Buttons 
               |                  |                |                   | 

 
 
 

One other point to remember is that your page can be larger than your desktop is. In this situation, you will have to 
slide the page around so that you are able to view all of it. These scroll bars  can occur on the side and on the bottom 
of your page. When you click on the arrow at the top (or in the direction that you want to slide the page) the page will 
be moved about one line up or over. If you click just below the arrow, the page will move one page at a time. You 
will now see an entirely new section to look at. If you want to move quickly through a document, without waiting for 
each section, click and hold your mouse button on the slide bar down while pulling your mouse in the direction you 
need to be sliding your page. This will move the page very quickly.  
 
 
 
_______________Scroll Bars : This one moves the page left to right.  
| 

There are still more common ways to help find out what you need to know within any program. 
 
One of these helps is called a “Pull-down-menu”. If you look at the top left corner of your screen you will notice 
several words that appear useless. These will actually give you many other options if you simply click on the word 

itself. The words that appear will vary according 
to the actual program you are using, but they are 
very commonly present.  

 
The File menu usually includes things like Print options, Page setup (margins), and exit the program. 
The Edit menu offers you cut, copy & paste options, as well as more editing functions. 
The View menu offers options that can change the way you look at your document. Big or small it’s up to you! 
The Help menu is where to begin looking for Help at. This can be a very beneficial tool, so use it! 
 
Now back to the Internet & writing a letter. Let’s say that you want to copy exactly some information from the 
Internet and place it into a letter that you are writing. There is a simple procedure for doing just that. We call this 
process “Cut, Copy & Paste”. 

 
Understanding cut, copy, & paste 

The cut, copy and past options are very useful tools and they are actually quite simple to understand. This page 
will help you make use of this Windows 95 feature. 
   First cut, copy & paste are universal actions, meaning that they can be used with nearly all programs on your 
computer. If you cut in one program it can be pasted into another program.  
 
Here are the specific instructions for cutting, copying & pasting for everyday use. 
1) To begin you must first highlight1 a section of text.  

                                                                 
1Highlighting is done by: clicking and holding down on your mouse button, while dragging the mouse so that all the desired text is 
highlighted, just release the mouse completely to leave the text highlighted.  



2) Next decide if this section needs to be cut2 or copied3. 
3) Click the option that you will use. (scissors for cut, two papers for copy) 

• (If you just used the cut option then your highlighted text has disappeared as of now, but is ready to be used 
elsewhere if desired.) 

 
 
If the paper that you are working looks great now then this is all that you need to do. If not continue down this page. 
4) To use the cut or copied text elsewhere in your paper. 

• First move your cursor to the location that you want to place the text at.  
• Click the paste button and ….. WOW! your text will appear right where you wanted it.  

 
To use cut, copy & paste with the Internet. 

1) Start by highlighting the text that you want to use (either for printing, or adding into a paper) 
2) Now click the copy option to copy the highlighted section of text into the computer’s memory. 
3) Now open the Word 97 program. (Programs like Word Pad, Notepad or any other text editor will do fine also.) 
• (Or a letter that you have started with your cursor placed where you want your Internet text placed at.)  
4) Click paste  to place the text from off the Internet onto your paper in Word 97. 
5) You can now either add more around this to make an informative letter, save this as a single file, or just print and 

not keep a computer copy of the information.  
 
Now that you are familiar with your Start button, the taskbar, maximize , minimize , restore  up, & restore  down, 
you have the basics to using nearly any program in the Windows environment.  
Exceptions to Windows:  
Many games do not use Windows , but rather operate in a system called DOS. DOS is NOT a friendly environment. If 
you end up stuck in DOS it can be very difficult. If you are just aware of the differences so that if you see them you 
won’t worry. When Windows is not working DOS usually works. Ask for help if you are faced with this scene c:\_!  
 
Windows  uses something called shortcuts to give us a way to access the programs we have on our computer. These 
shortcuts can be placed anywhere and once clicked upon they redirect us to program we had wanted to use. 
Shortcuts can be moved and recreated without causing any damage to the actual programs.  
 

Creating shortcuts4 with Windows 
To create a shortcut to be located on your computer's desktop try this: 
 
1) Place your mouse on a clear i spot on your computer's desktopii. 
2) Use your right mouse button and click once. 
3) Look at the menu that appears on the screen. 
4) Move your cursor to the word "new". 
5) Hold your cursor there while a secondary menu appears. 
6) This menu will contain "folder" and "shortcut " as well as other options. 
7) Click on the word "shortcut ". 
8) This now brings up a screen that shows a long white box with the words "command line i i i" above it. Below the box 
is a button that says, "browseiv". Click on that button.  
9) Now you are sent to a screen that lists all the contents within your computer. You need to try to locate the working 
file for the program that you want to have the shortcut for.  

                                                                 
2 Cut means to remove from a given location, with an option of placing it elsewhere. 
3 Copy means to leave the text where it is, but to make a mental copy of the information to be used again els ewhere with exact wording. 
4 A “shortcut” is an easy way to find the things you need without having to “browse” the computer each time.  



10) Click once (left mouse button) on the name of the program. 
11) This copies the exact name of the program into the box shown next to the box at the bottom of that screen "file 
name ".  
12) Once that part is done click the button on the right that says, "open". 
13) Now you are sent back to the original screen containing the large box with the words "command line " above it.  
14) Now you are ready to click the button at the bottom of that screen that says, "next". 
15) The next screen gives you an option of changing the name to something different. If you know what the program 
is without changing it then skip past this part and go directly to the "finish" button. 
16) After clicking wait for just a few seconds and a new icon will appear on your computer screen.  
 
To create a shortcut to be located within your start menu: 
 
1) Click your start button. 
2) Move your cursor over the word "settings". 
3) Move your cursor right and down to the word "taskbar". 
4) Look at the top of this new screen, notice the two tabs at the top saying "taskbar options " & "start menu 
programs ". 
5) Click on the top tab saying, "start menu programs ". 
6) The top part of this new page says, "customizing your start menu". From this place you can add or remove icons 
listed in your start menu.  
7) For this use we will click the word "add". 
8) This brings you to the screen described in # 8 – 12 above. (Follow directions listed above.) 
9) Once you have selected the program that you want to add to your menu, then you are sent to a screen showing all 
the folders within your start menu. You need to decide just where you want to place the latest icon. You can create a 
new folder to place it in, if needed.  
10) Click on "next" to continue. 
11) Follow # 15 above here and then click "finish". 
 
The text style of "bold Italic' text is used to indicate something that you must do to accomplish what is described. 
The text style of "bold type " is used to indicate a specific wording to look for. 
The text style of "underline" is used to indicate an object to look for. 
 

Be not afraid of your computer! If you forget to Shut Down your computer properly it will be just fine. If this 
happens just do what it tells you to do. There are very few things that you can do that will seriously damage your 
computer. If you use the control panel carelessly without understanding what you are getting into it is possible to 
cause the computer to not work properly. The only other problem that can seriously harm your computer is a virus, 
but we will cover that is another class.   
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i Empty, blank, vacant or section on your computer screen that is free of icons. 
ii Desktop is the part of your computer that you look at before you start any programs up. It can also be called a computer screen. Desktop is a 
Windows 95 term. 
iii A "command line" is a line of text that contains an exact file name as well as the exact way to find it on the computer. The way to find 
where the program is located is often referred to as a path.  
iv Browse means "lets look in the filing cabinet called your computer", it shows you everything that is being stored on your hard drive.   
 


